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EXERCISE NO 1 

STUDY OF ELECTRONIC COMPONENTS 

 
OBJECTIVES 

a. To get familiar with basic electronic components such as Resistor, capacitors, 

Inductor, diodes, transistors, integrated circuits (IC), light emitter diode (LED), 

switches, fuses, batteries, power plugs, connectors, wires and cables. 

b. To test and understand the function of various electronic components. 

 
RESISTORS 

A resistor is a passive two-terminal electrical component that implements electrical 

resistance as a circuit element. The current through a resistor is in direct proportion to the 

voltage across the resistor's terminals. This relationship is represented by Ohm's law. A 

device used in electrical circuits to maintain a constant relation between current flow and 

voltage. Resistors are used to step up or lower the voltage at different points in a circuit and 

to transform a current signal into a voltage signal or vice versa, among other uses. The 

electrical behaviour of a resistor obeys Ohm's law for a constant resistance; however, some 

resistors are sensitive to heat, light, or other variables. 

Resistors are one of the most used components in a circuit. Most are color coded, but 

some have their value in Ohms and their tolerance printed on them. A multimeter that can 

check resistance can also be helpful, providing the resistor is already removed from the board 

(measuring it while still soldered in can give inaccurate results, due to connections with the 

rest of the circuit). They are typically marked with an “R” on a circuit board. 

 

POTENTIOMETERS 

Potentiometers are variable resistors. They normally have their value marked with the 

maximum value in Ohms. Smaller trimpots may use a 3-digit code where the first 2 digits are 

significant, and the 3rd is the multiplier (basically the number of 0′s after the first 2 digits).  

For example, code 104 = 10 followed by four 0′s = 100000 Ohms = 100K Ohms. They may 

also have a letter code on them indicating the taper (which is how resistance changes in 

relation to how far the potentiometer is turned). They are typically marked with an “VR” on a 

circuit board. 

http://en.wikipedia.org/wiki/Passivity_(engineering)
http://en.wikipedia.org/wiki/Terminal_(electronics)
http://en.wikipedia.org/wiki/Electronic_component
http://en.wikipedia.org/wiki/Electrical_resistance
http://en.wikipedia.org/wiki/Electrical_resistance
http://en.wikipedia.org/wiki/Electric_current
http://en.wikipedia.org/wiki/Direct_proportion
http://en.wikipedia.org/wiki/Voltage
http://en.wikipedia.org/wiki/Ohm%27s_law
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CAPACITORS 

A capacitor (originally known as a condenser) is a passive two-terminal electrical 

component used to store energy electrostatically in an electric field. By contrast, batteries 

store energy via chemical reactions. The forms of practical capacitors vary widely, but all 

contain at least two electrical conductors separated by a dielectric (insulator); for example, 

one common construction consists of metal foils separated by a thin layer of insulating film. 

Capacitors are widely used as parts of electrical circuits in many common electrical devices. 

 
Capacitors are also very commonly used. A lot have their values printed on them, 

some are marked with 3-digit codes, and a few are color coded. The same resources listed 

above for resistors can also help you identify capacitor values. They are typically marked 

with an “C” on a circuit board. 

 

 
 

 
INDUCTORS 

 
An inductor, also called a coil or reactor, is a passive two-terminal electrical 

component which resists changes in electric current passing through it. It consists of a 

conductor such as a wire, usually wound into a coil. When a current flows through it, energy 

is stored in a magnetic field in the coil. When the current flowing through an inductor 

changes, the time-varying magnetic field induces a voltage in the conductor, according to 

http://en.wikipedia.org/wiki/Passivity_(engineering)
http://en.wikipedia.org/wiki/Terminal_(electronics)
http://en.wikipedia.org/wiki/Electronic_component
http://en.wikipedia.org/wiki/Electronic_component
http://en.wikipedia.org/wiki/Energy
http://en.wikipedia.org/wiki/Electrostatic
http://en.wikipedia.org/wiki/Electric_field
http://en.wikipedia.org/wiki/Battery_(electricity)
http://en.wikipedia.org/wiki/Chemical_reaction
http://en.wikipedia.org/wiki/Electrical_conductor
http://en.wikipedia.org/wiki/Dielectric
http://en.wikipedia.org/wiki/Insulator_(electricity)
http://en.wikipedia.org/wiki/Electrical_circuit
http://en.wikipedia.org/wiki/Passivity_(engineering)
http://en.wikipedia.org/wiki/Terminal_(electronics)
http://en.wikipedia.org/wiki/Electronic_component
http://en.wikipedia.org/wiki/Electronic_component
http://en.wikipedia.org/wiki/Electric_current
http://en.wikipedia.org/wiki/Coil_(electrical_engineering)
http://en.wikipedia.org/wiki/Energy
http://en.wikipedia.org/wiki/Magnetic_field
http://en.wikipedia.org/wiki/Voltage
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Faraday’s law of electromagnetic induction, which by Lenz's law opposes the change in 

current that created it. 

 
Inductors, also called coils, can be a bit harder to figure out their values. If they are color 

coded, the resources listed for resistors can help, otherwise a good meter that can measure 

inductance will be needed. They are typically marked with an “L” on a circuit board. 

 

 

TRANSFORMERS 

A transformer is a static electrical device that transfers energy by inductive coupling 

between its winding circuits. A varying current in the primary winding creates a varying 

magnetic flux in the transformer's core and thus a varying magnetic flux through the 

secondary winding. This varying magnetic flux induces a varying electromotive force (emf) 

or voltage in the secondary winding. 

Transformers are normally pretty easy to identify by sight, and many have their specs printed 

on them. They are typically marked with an “T” on a circuit board. 

 

 

FUSES 

In electronics and electrical engineering, a fuse is a type of low resistance resistor that 

acts as a sacrificial device to provide overcurrent protection, of either the load or source 

circuit. Its essential component is a metal wire or strip that melts when too much current 

flows, which interrupts the circuit in which it is connected. Short circuit, overloading, 

mismatched loads or device failure are the prime reasons for excessive current. A fuse 

interrupts excessive current (blows) so that further damage by overheating or fire is 

prevented. Fuses can be easy to identify, and typically have their voltage and amperage rating 

marked on them. 

http://en.wikipedia.org/wiki/Faraday%27s_law_of_induction
http://en.wikipedia.org/wiki/Lenz%27s_law
http://en.wikipedia.org/wiki/Inductive_coupling
http://en.wikipedia.org/wiki/Electric_current
http://en.wikipedia.org/wiki/Magnetic_flux
http://en.wikipedia.org/wiki/Magnetic_core
http://en.wikipedia.org/wiki/Electromagnetic_induction
http://en.wikipedia.org/wiki/Electromotive_force
http://en.wikipedia.org/wiki/Voltage
http://en.wikipedia.org/wiki/Electronics
http://en.wikipedia.org/wiki/Electrical_engineering
http://en.wikipedia.org/wiki/Resistor
http://en.wikipedia.org/wiki/Sacrificial_device
http://en.wikipedia.org/wiki/Overcurrent
http://en.wikipedia.org/wiki/Electrical_network
http://en.wikipedia.org/wiki/Short_circuit
http://en.wikipedia.org/wiki/Fire
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SEMICONDUCTORS 

 
DIODES 

In electronics, a diode is a two-terminal electronic component with asymmetric 

conductance, it has low (ideally zero) resistance to current flow in one direction, and high 

(ideally infinite) resistance in the other. 

 
Semiconductors, such as Diodes (typically marked with an “D” on a circuit board). 

 

 

TRANSISTORS 

A transistor is a semiconductor device used to amplify and switch electronic signals 

and electrical power. It is composed of semiconductor material with at least three terminals 

for connection to an external circuit. A voltage or current applied to one pair of the 

transistor's terminals changes the current through another pair of terminals. Because the 

controlled (output) power can be higher than the controlling (input) power, a transistor can 

amplify a signal. Today, some transistors are packaged individually, but many more are 

found embedded in integrated circuits. 

Transistors (typically marked with an “Q” on a circuit board). 

http://en.wikipedia.org/wiki/Electronics
http://en.wikipedia.org/wiki/Terminal_(electronics)
http://en.wikipedia.org/wiki/Electronic_component
http://en.wikipedia.org/wiki/Electrical_conductance
http://en.wikipedia.org/wiki/Electrical_resistance_and_conductance
http://en.wikipedia.org/wiki/Infinity
http://en.wikipedia.org/wiki/Semiconductor_device
http://en.wikipedia.org/wiki/Electronic_amplifier
http://en.wikipedia.org/wiki/Switch
http://en.wikipedia.org/wiki/Switch
http://en.wikipedia.org/wiki/Electrical_power
http://en.wikipedia.org/wiki/Semiconductor
http://en.wikipedia.org/wiki/Electric_current
http://en.wikipedia.org/wiki/Electric_power
http://en.wikipedia.org/wiki/Gain
http://en.wikipedia.org/wiki/Integrated_circuit
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BRIDGE RECTIFIERS 

 
A diode bridge is an arrangement of four (or more) diodes in a bridge circuit 

configuration that provides the same polarity of output for either polarity of input. When used 

in its most common application, for conversion of an alternating current (AC) input into a 

direct current (DC) output, it is known as a bridge rectifier. A bridge rectifier provides full- 

wave rectification from a two-wire AC input, resulting in lower cost and weight as compared 

to a rectifier with a 3-wire input from a transformer with a center-tapped secondary winding. 

 
Bridge Rectifiers (typically marked with an “BR” on a circuit board) 

 
 

 

INTEGRATED CIRCUITS 

An integrated circuit or monolithic integrated circuit (also referred to as an IC, a chip, 

or a microchip) is a set of electronic circuits on one small plate ("chip") of semiconductor 

material, normally silicon. This can be made much smaller than a discrete circuit made from 

independent components. Integrated circuits are used in virtually all electronic equipment 

today and have revolutionized the world of electronics. Computers, mobile phones, and other 

digital home appliances are now inextricable parts of the structure of modern societies, made 

possible by the low cost of producing integrated circuits. 

 
Integrated Circuits (typically marked with an “U” or “IC” on a circuit board) 

http://en.wikipedia.org/wiki/Diode
http://en.wikipedia.org/wiki/Bridge_circuit
http://en.wikipedia.org/wiki/Polarity_(physics)
http://en.wikipedia.org/wiki/Alternating_current
http://en.wikipedia.org/wiki/Direct_current
http://en.wikipedia.org/wiki/Rectifier
http://en.wikipedia.org/wiki/Rectifier#Full-wave_rectification
http://en.wikipedia.org/wiki/Rectifier#Full-wave_rectification
http://en.wikipedia.org/wiki/Transformer
http://en.wikipedia.org/wiki/Center_tap
http://en.wikipedia.org/wiki/Electronic_circuit
http://en.wikipedia.org/wiki/Semiconductor_material
http://en.wikipedia.org/wiki/Semiconductor_material
http://en.wikipedia.org/wiki/Silicon
http://en.wikipedia.org/wiki/Discrete_circuit
http://en.wikipedia.org/wiki/Electronics
http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Mobile_phone
http://en.wikipedia.org/wiki/Home_appliances
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LED AND LED DISPLAY 

A light-emitting diode (LED) is a semiconductor light source. LEDs are used as 

indicator lamps in many devices and are increasingly used for other lighting. LEDs emitted 

low-intensity red light, but modern versions are available across the visible, ultraviolet, and 

infrared wavelengths, with very high brightness. 

 

 
 

 
SWITCHES 

In electrical engineering, a switch is an electrical component that can break an 

electrical circuit, interrupting the current or diverting it from one conductor to another. The 

most familiar form of switch is a manually operated electromechanical device with one or 

more sets of electrical contacts, which are connected to external circuits. Each set of contacts 

can be in one of two states: either "closed" meaning the contacts are touching and electricity 

can flow between them, or "open", meaning the contacts are separated and the switch is 

nonconducting. 

http://en.wikipedia.org/wiki/Semiconductor
http://en.wikipedia.org/wiki/Visible_spectrum
http://en.wikipedia.org/wiki/Ultraviolet
http://en.wikipedia.org/wiki/Infrared
http://en.wikipedia.org/wiki/Electrical_engineering
http://en.wikipedia.org/wiki/Electrical_component
http://en.wikipedia.org/wiki/Electrical_circuit
http://en.wikipedia.org/wiki/Electric_current
http://en.wikipedia.org/wiki/Electromechanical
http://en.wikipedia.org/wiki/Electrical_contacts
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BATTERIES 

In electricity, a battery is a device consisting of one or more electrochemical cells that 

convert stored chemical energy into electrical energy. 

Batteries are also pretty easy to identify, and are well marked with their specification. 
 
 

 

RELAYS 

A relay is an electrically operated switch. Many relays use an electromagnet to 

operate a switching mechanism mechanically, but other operating principles are also used. 

Relays are used where it is necessary to control a circuit by a low-power signal (with 

complete electrical isolation between control and controlled circuits), or where several 

circuits must be controlled by one signal. 

 
Relays are typically enclosed in plastic, and many have their specs printed on them. They are 

typically marked with a “K” on a circuit board. 

 

http://en.wikipedia.org/wiki/Electricity
http://en.wikipedia.org/wiki/Electrochemical_cell
http://en.wikipedia.org/wiki/Energy
http://en.wikipedia.org/wiki/Electric
http://en.wikipedia.org/wiki/Switch
http://en.wikipedia.org/wiki/Electromagnet
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Lab Exercise 

 
EQUIPMENT REQUIRED 

Electronic components (Resistor, capacitors, diode, Transistor) 

Digital multimeter (DMM) 

 
A1. Determining Resistor values 

 

 
 

Resistor Colour Codes 
 

 

 

 

 

 
1st digit 

2nd digit 

 
Tolerance 

Multiplier (no. of zeros, 

following 2nd digit) 

 

Colour-code bands on a 

resistor. 

 
 

Colour Band 1 Band 2 Band 3 Band 4 

Black 0 0 ×1 – 

Brown 1 1 ×10 1% 

Red 2 2 ×100 2% 

Orange 3 3 ×1000 – 

Yellow 4 4 ×10000 – 

Green 5 5 ×100000 0.5% 

Blue 6 6 ×1000000 0.25% 

Violet 7 7 ×10000000 0.1% 

Grey 8 8 – – 

White 9 9 – – 

Gold – – ×0.1 5% 

Silver – – ×0.01 10% 
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Resistance measurement 

Procedure 

1. Connect probes: black probe to COM terminal and red probe to terminal marked with ‘ 

2. Set function to resistance measurement 

3. Set to the appropriate range (refer to above) 

4. Connect the two probes’ crocodile clips to the resistor (or to the resistor circuit via jumper 

wires) to make measurement 

5. Note the reading, adjust range if necessary 

6. Take the more accurate reading. 

 
Determine the value for the given data 

 
 

No. Colour code Actual Value 
Measured Value 

(DMM) 

1 Red, red, black 
  

2 Red, black, orange 
  

3 Blue, gray, green 
  

4 
 

10M 
 

5 
 

33K 
 

 

 
A2. Determining capacitor values 

 

 

 
 

Code Tolerance 

C ±0.25pF 

J ±5% 

K ±10% 

M ±20% 

D ±0.5pF 

Z 80% / -20% 

’ 
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Determine the value of the ceramic capacitors 
 
 

No. Code Number Actual Value 

1 104 
 

2 223 
 

3 68 
 

4 
 

0.47 F 

5 
 

33nF 

 

 
A3. Diode Testing 

 

Draw the schematic symbol of a 1N4001 diode and identify the leads (Anode and Cathode) in 

the box below. 

 

 

a. Set the Lab DMM to Diode Testing mode. 

 
b. Measure the forward and reverse bias voltages of the given diodes and record them 

i. Forward bias voltage: 

Place the RED probe on the Anode. Touch the BLACK probe to the Cathode and 

record the reading 

ii. Reverse bias voltage: 

Place the RED probe on the Cathode. Touch the BLACK probe to the Anode and 

record the reading 
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No. Diode Number Forward Bias Voltage Reverse Bias Voltage 

 

 

 
1 

1N4001 
 

 
 

  

 

 

 
2 

1N914 
 

 
 

  

 

Result: 
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EXPERIMENT NO 2 

 
STUDY OF INSTRUMENTS AND EQUIPMENTS 

OBJECTIVES 

a. To get familiar with basic electronic instrument and Equipment handling and usage 

procedure for Digital Multimeter, DC power supply, Function Generator and CRO. 

b. To study the self test / calibration procedure of CRO. 
 

 

 

 
INTRODUCTION 

2A DIGITAL MULTI METER 

 

A Multimeter is an electronic device that is used to make various electrical measurements, 

such as AC and DC voltage, AC and DC current, and resistance. It is called a Multimeter 

because it combines the functions of a voltmeter, ammeter, and ohmmeter. Multimeter may also 

have other functions, such as diode test, continuity test, transistor test, TTL logic test and 

frequency test. 

 
PARTS OF MULTIMETER 

A Multimeter has three parts: 
 

Display 

Selection Knob 

Ports 

 

The display usually has four digits and the ability to display a negative sign. A few 

multimeters have illuminated displays for better viewing in low light situations. 

The selection knob allows the user to set the multimeter to read different things such as 

milliamps (mA) of current, voltage (V) and resistance (Ω). 

Two probes are plugged into two of the ports on the front of the unit. COM stands for 

common and is almost always connected to Ground or ‘-’ of a circuit. The COM probe is 

conventionally black but there is no difference between the red probe and black probe other than 

color. 10A is the special port used when measuring large currents (greater than 

200mA). mAVΩ is the port that the red probe is conventionally plugged in to. This port allows 

the measurement of current (up to 200mA), voltage (V), and resistance (Ω). The probes have 

a banana type connector on the end that plugs into the multimeter. Any probe with a banana plug 

will work with this meter. 
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SAFETY MEASURES 
 

    Be sure the test leads and rotary switch are in the correct position for the desired 

measurement. 

    Never use the meter if the meter or the test leads look damaged. 

   Never measure resistance in a circuit when power is applied. 

    Never touch the probes to a voltage source when a test lead is plugged into the 10 A or 

300 mA input jack. 

    To avoid damage or injury, never use the meter on circuits that exceed 4800 watts. 

   Never apply more than the rated voltage between any input jack and earth ground. 

    Be careful when working with voltages above 60 V DC or 30 V AC rms. Such voltages 

pose a shock hazard. 

    Keep your fingers behind the finger guards on the test probes when making 

measurements. 

    To avoid false readings, which could lead to possible electric shock or personal injury, 

replace the battery as soon as the battery indicator appears. 
 

INPUT JACKS 

 
The black lead is always plugged into the common terminal. The red lead is plugged into 

the 10 A jack when measuring currents greater than 300 mA, the 300 mA jack when measuring 

currents less than 300 mA, and the remaining jack (V-ohms-diode) for all other measurements. 
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RANGE FIXING 

 
The meter defaults to autorange when first turned on. You can choose a manual range in 

V AC, V DC, A AC, and A DC by pressing the button in the middle of the rotary dial. To return 

to autorange, press the button for one second. 

 
 

 

 
PROCEDURE FOR MEASUREMENT 

VOLTAGE MEASUREMENT 

D.C. / A.C. Voltage Measurment 

1. Connect the positive(red) test lead to the ‘V/mA’ jack socket and the negative(black) lead 

to the ‘COM’ jack socket. 

2. Set the selector switch to the desired mV D.C./D.C.V/A.C.V range. 

3. Connect the test leads to the circuit to be measured. 

4. Turn on the power to the circuit to be measured, the voltage value should appear on the 

digital display along with the voltage polarity(if reversed only). 



17  

 
   

 

 

CURRENT MEASUREMENT 

 

1. Connect the positive(red) test lead to the ‘V/mA’ jack socket and the negative(black) lead 

to the ‘COM’ jack socket(for measurements up to 200mA). For measurements between 

200mA and 10A connect the red test lead to the ‘10mA’ socket. 

2. Set the selector switch to the desired uA/mA/A range. 

3. Open the circuit to be measured and connect the test leads in SERIES with the load in 

which current is to be measured. 

4. To avoid blowing an input fuse, use the 10A jack until you are sure that the current is less 

than 300 mA. Turn off power to the circuit. Break the circuit. (For circuits of more than 

10 amps, use a current clamp.) Put the meter in series with the circuit and turn power on. 
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RESISTANCE MEASUREMENT 

 
1. Connect the positive(red) test lead to the ‘V/mA’ jack socket and the negative(black) lead 

to the ‘COM’ jack socket. 

2. Set the selector switch to the desired ‘OHM Ω’. 

3. If the resistance to be measured ia part of a circuit, turn off the power and discharge all 

capacitors before measurement. 

4. Connect the test leads to the circuit to be measured. 

5. The resistance value should now appear on the digital display. 

6. If the resistance to be measured is part of a circuit, turn off the power and discharge all 

capacitors before measurement. 

 

 

 

 

 

 
CONTINUITY TEST 

 
This mode is used to check if two points are electrically connected. It is often used to 

verify connectors. If continuity exists (resistance less than 210 ohms), the beeper sounds 

continuously. 

 

1. Connect the positive(red) test lead to the ‘V/mA’ jack socket and the negative(black) lead 

to the ‘COM’ jack socket. 

2. Set the selector switch to the  position. 

3. Connect the test leads to two points of the circuit to be tested. If the resistence is Ohms 

the buzzer will sound. 
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4. If the resistance to be measured is part of a circuit, turn off the power and discharge all 

capacitors before measurement. 
 
 
 

 

 

 
DIODE TEST 

 
1. Connect the positive (red) test lead to the ‘V/mA’ jack socket and the negative(black) 

lead to the ‘COM’ jack socket. 

2. Set the selector switch to the position. 

3. Connect the test leads to be measured. 

4. Turn on the power to the circuit to be measured and the voltage value should appear on 

the digital display. 
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’ 

General Operation 
 

Connection of Probes: 

All multimeters come with two probes. They are to be connected to the terminals on the meter itself. The 

Black probe is to be connected to the COM terminal. Red probe is to be connected to terminal marked 

with : 

‘V- ’ for voltage measurement, 

‘mA’ or ‘20A’ for current measurement (there are two terminals, one for 2A range and the other for 

20A range) 

‘V- for resistance measurement. 

Setting of function: 

The multimeter uses different circuits internally to measure different things. Therefore, you must select 

the correct function before using it. 

Setting of Range: 

   You can change the sensitivity of the meter by selecting different range for measurement. Set the 

range to the first range that is higher than the maximum value you expect to measure. This will 

give a more accurate reading. If you do not know what to expect, use the highest range first. 

After a reading is obtained, set the range to the appropriate one to get a better reading. 

   When the value measured exceeds the existing range, the display will flash. When this happens, 

set the multimeter to a higher range until some values are displayed. 

 
 

Precautions: 
 

1. For current measurement, the maximum input current is 2A (if the RED mA and BLACK COM 

terminals are used) or 20A (if the RED 20A and BLACK COM terminals are used). Excessive current 

will blow the fuse on the 2A range, which must be replaced. The 20A range, however, is not 

protected by the fuse. 

2. For voltage measurement (use the RED V- and BLACK COM terminals), the maximum input 

voltage on : 

all DC ranges is 1200V DC or peak AC 

the 20V, 200V and 1000V AC ranges is 1000V rms continuous 

the 2V and 200mV AC ranges is 1000V rms for not more than 15 seconds. 

3. To avoid electrical shock and/or instrument damage, do not connect the COM input terminals to any 

source of more than 500 volts DC or peak AC above earth ground. 

Resistance measurement 

Procedure 

1. Connect probes: black probe to COM terminal and red probe to terminal marked with ‘  ’ 

2. Set function to resistance measurement 

3. Set to the appropriate range (refer to above) 

4. Connect the two probes’ crocodile clips to the resistor (or to the resistor circuit via jumper wires) to 

make measurement 

5. Note the reading, adjust range if necessary 

6. Take the more accurate reading. 
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i 
+ 

A 
COM 

Voltage measurement 

Procedure 

7. Connect probes: black probe to COM terminal and red probe to terminal marked with ‘V’ 

8. Set function to voltage measurement 

9. Set to the appropriate range (refer to above) 

10. Set the AC-DC selection - depends on what type of signal you want to measure 

11. Touch the two points where you want to make measurement 

12. Note the reading, adjust range if necessary 

13. Take the more accurate reading. 

 
Note 

Reading obtained is the voltage of where the red probe touch with reference to where the black probe 

touches. This may not indicate the voltage level from ground. To find the voltage level of a point from 

ground, black probe should be touching a ground point and the red probe on the point you want to 

measure. 

 
Current measurement 

Procedure 

1. Connect probes: black probe to COM terminal and red probe to terminal marked with ‘A’ 

2. Set function to current measurement 

3. Set to the appropriate range 

4. Set AC-DC selection - depends on what type of signal you want to measure 

5. Off the power to the circuit 

6. Break the path which we want to make measurement 

7. Connect the path with the two probes so that current now flow through the multimeter 

8. On the power 

9. Note the reading, change range if necessary 

10. Take the more accurate reading. 

Note 

Use the 20A range if you are not sure of the current to be measured. 

Connection Methods to Measure Voltage and Current 
 

 

 

 

Power 
Supply 

 

+ 
V 

COM 

Power 
Supply 

 
 

Multimeter 

 
 

Multimeter 

Voltage Measurement Current Measurement 
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Objective 

2B DC VARIABLE POWER SUPPLY 

 

    To study the function and operation of regulated power supply. 

Equipment required 

Multimeter 

Dual DC variable regulated Power supply (0-30) Volts 

 
Theory 

A power supply is a device that supplies electric power to an electrical load. The term 

is most commonly applied to electric power converters that convert one form of electrical energy 

to another, though it may also refer to devices that convert another form of energy (mechanical,  

chemical, solar) to electrical energy. A regulated power supply is one that controls the output 

voltage or current to a specific value; the controlled value is held nearly constant despite 

variations in either load current or the voltage supplied by the power supply's energy source. 

A power supply may be implemented as a discrete, stand-alone device or as an integral 

device that is hardwired to its load. Examples of the latter case include the low voltage DC 

power supplies that are part of desktop computers and consumer electronics devices. 

Commonly specified power supply attributes include: 
 

    The amount of voltage and current it can supply to its load. 

    How stable its output voltage or current is under varying line and load conditions. 

 

POWER SUPPLIES TYPES 

   Battery 

   DC power supply 

  AC power supply 

   Linear regulated power supply 

  Switched mode power supply 

  Programmable power supply 

  Uninterruptible power supply 

  High voltage power supply 

Voltage multipliers 

http://en.wikipedia.org/wiki/Electric_power
http://en.wikipedia.org/wiki/Electrical_load
http://en.wikipedia.org/wiki/Electric_power_converter
http://en.wikipedia.org/wiki/Regulated_power_supply
http://en.wiktionary.org/wiki/hardwired
http://en.wikipedia.org/wiki/Desktop_computer
http://en.wikipedia.org/wiki/Consumer_electronics
http://en.wikipedia.org/wiki/Voltage
http://en.wikipedia.org/wiki/Current_(electricity)
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DC POWER SUPPLY 

SPECIFICATION 

1. Adjustable 0~30V/0~2A 

2. The design is limit the voltage overload 

The power supply input 220V, 230V, 240V AC 

3. Output voltage: 0-30V DC 

4. Work temperature: -10oC-40oC 

 
MAIN FUNCTION 

1. Output constant current adjustable. 

2. Output constant voltage adjustable. 

3. LCD voltage and current display. 

4. Constant voltage and current operation in individual. 

5. Over current protection. 

 
Adjustable power supply 
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2C CATHODE-RAY OSCILLOSCOPE (CRO) 

 
Objective 

• To introduce the basic structure of a cathode-ray Oscilloscope. 

• To get familiar with the use of different control switches of the device. 

• To visualize an ac signal, measure the amplitude and the frequency. 

To do self test/ calibration of CRO 
 

Equipment Required 

• Cathode-ray Oscilloscope 

• Function Generator 

• BNC connector 

Theory 

 
The device consists mainly of a vacuum tube which contains a cathode; anode, grid, 

X&Y-plates, and a fluorescent screen (see Figure below). When the cathode is heated (by 

applying a small potential difference across its terminals), it emits electrons. Having a potential 

difference between the cathode and the anode (electrodes), accelerate the emitted electrons 

towards the anode, forming an electron beam, which passes to fall on the screen. 

When the fast electron beam strikes the fluorescent screen, a bright visible spot is 

produced. The grid, which is situated between the electrodes, controls the amount of electrons 

passing through it thereby controlling the intensity of the electron beam. The X&Y- plates are 

responsible for deflecting the electron beam horizontally and vertically. 

A sweep generator is connected to the X-plates, which moves the bright spot 

Horizontally across the screen and repeats that at a certain frequency as the source of the signal. 

The voltage to be studied is applied to the Y-plates. The combined sweep and Y voltages 

produce a graph showing the variation of voltage with time. 

 
Experimental Figures 

 

 

 
Fig 1. Cathode Ray tube Oscilloscope Fig 2. Out Line Diagram of CRO 
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Procedure 

1. Turn on the Oscilloscope 

2. Adjust the intensity and the focus of the trace. 

3. Use the X & Y knobs to center the trace horizontally and vertically. 

4. Connect the cable from Ch1 of the CRO to Function generator. 

5. A signal will appear on the screen. 

6. Make sure that the inner red knobs of the Volt/Div and the Time/Div are locked 

clockwise. 

7. Set the frequency of the generator to 100 Hz. 

8. Adjust the Volt/Div and the Time/Div knobs so that you get a suitable size signal 

9. Count the number of vertical squares lying within the signal, then calculate the peak to peak 

value as: 

 

Vp-p = No. vertical Div * Volt/Divs 

 
10. Count the number of horizontal squares lying within the one Duty Cycle, then 

calculate time value as: 

 

Time = No. Horizontal Div * Time/Divs 

11.Calculate the Frequency of signal by using the formula: 

Freq = 1 /Time 

 
Result: 
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2D FUNCTION GENERATOR 
 

Objective 

 
1. To get familiarization and study the operation of a function generator instrument 

2. To identify key function generator specifications 

3. To visualize the types of waveforms produced by a function generator 

Equipment Required 

Oscilloscope 

Function generator. 

BNC connector cable 

Theory 

A function generator is electronic test equipment used to generate different types of 

waveforms over a wide range of frequencies. Function generators are capable of producing a 

variety of repetitive waveforms, generally from the list below 
 

    Sine wave: A function generator will normally have the capability to produce a standard 

sine wave output. This is the standard waveform that oscillates between two levels with a 

standard sinusoidal shape. 

 

 
    Square wave: A square wave is normally relatively easy for a function generator to 

produce. It consists of a signal moving directly between high and low levels. 

 

 

    Pulse:   A pulse waveform is another type that can be produced by a function generator. 

It is effectively the same as a square wave, but with the mark space ratio very different to 

1:1. 

 

 
    Triangular wave: This form of signal produced by the function generator linearly 

moves between a high and low point. 
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sinusoidal waveform on the screen. 

Function Generator connected 

 
 

    Saw tooth wave: Again, this is a triangular waveform, but with the rise edge of the 

waveform faster or slower than the fall, making a form of shape similar to a saw tooth. 

 
 

These waveforms can be either repetitive or single-shot Function generators are used in the 

development, test and repair of electronic equipment. 

Types of Function Generator 

 

 

 

 

 

 

 

 

 

 

 

 

 
PROCEDURE 

1. Turn on the oscilloscope 

2. Connect the function generator to one vertical channel of the oscilloscope using BNC 

Connector 

3. Select the type of wave form by pressing Function control button. 

4. Set the waveform at desired frequency by adjusting Frequency variable control button. 

5. Now adjust the amplitude control of the function generator to establish a 4 V peak-to-peak 

(p-p) 
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Function Generator Controls 
 
 

Knobs 

Number 

Control Name Functions 

1 Power Push button switch to power ON the instrument. 

2 LCD Display 20 x 4 Character bright back lit Liquid Crystal Display. 

3 Frequency Used for selection of frequency range step by step. 

 

 

 
4 

 

 

 
Function 

Used for selection of Particular waveform. A total number of 6 

different waveforms : 

 Sine 

 Square 

 Triangle 

 Ramp 

 Pulse 

 TTL are available. 

5 Modulation Used for selection of Frequency Modulation. 

6 Attenuation Used for Selection of 20dB or 40dB attenuation 

7 Menu Used for selection of Function Generator/Frequency counter 

mode. 

8 Duty Cycle When pulse output function is selected, this controls the pulse 

duty cycle from 15% to 85%. 

9 Frequency 

Variable 

In conjunction with frequency range, selected by frequency key 

on front Panel. 

10 Amplitude 

Variable 

In conjunction with attenuators (6), this varies the level of output. 

 
11 

 
DC Offset 

This control provides DC offset. Approximately ±5VDC is 

superimposed on the output. Keep the control off if DC offset is 

not required. 

12 Output (BNC 

connector) 

Output of 10 MHz function generator i.e. 20Vpp (Open Circuit) 

 
13 

External 

Counter (BNC 

Connector) 

Input BNC connector for measuring the frequency of external 

signal when External Counter mode is selected by 

Menu key on the LCD display. 

14 Modulation 

Input 

Maximum modulation Input i.e. 2Vpp. 
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LAB Exercise 
 

 

2A DIGITAL MULTI METER 

observation 

Description Value 

Measurement of line voltage (ac)  

Measurement of resistance  

Measurement of continuity  

 

 
2B DC VARIABLE POWER SUPPLY 

Set 5V in both channel 

 
2C CATHODE-RAY OSCILLOSCOPE (CRO) 

 
 

Self test of CRO 

Description Value 

Measurement of voltage  

Measurement of Time  

Calculated frequency  

 

 
2D FUNCTION GENERATOR 

 

Set sine wave Hz and display in CRO 

Set Triangle/ Square wave and display in CRO 

observation 

 

 

 

 

Result 

Description Sine wave Square Wave 

Measurement of voltage   

Measurement of Time   

Calculated frequency   
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Introduction to TINA Software 

PART 1 – TINA Schematic Editor 
 

General Instructions to Create circuit Schematic Design 

Launch TINA Editor from Start- All programs – TINA 9: Move your cursor to the Toolbar and tips will 

appear as you move from one icon to another.   Spend a few minutes to familiarize yourself with the 

Menu bar, Toolbars and Icons. 

At the top of the window, other than the Menu Bar, 

(i) Standard Toolbar 

(ii) Schematic Editing Toolbar There is also a Status Bar at the bottom of the screen. 
 
 

 

 
Figure 1:TINA Schematic Editor Window 
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Figure 2:TINA Basic Screen Format 

 

 
After start-up, the following screen appears on your monitor: 

The Menu bar 

The Cursor or pointer: This is used to select commands and to edit schematics. You can 

move the cursor only with the mouse. Depending on the mode of operation, the cursor assumes 

one of the following forms: An arrow, when a command selection is required in the edit 

window. A component symbol (accompanied by an arrow and small box), when inserting that 

component onto the circuit in the schematic window. Until the position of the component on the 

schematic is chosen, its movement is controlled by the mouse. A pen, when defining the 

endpoint of a wire. An elastic line, when defining the endpoint of a wire or the second node of 

an input or output. An elastic box, when defining a block after fixing its first corner. A dashed 

line box, when positioning a component label or a text block. A magnifying glass, when 

defining a zoom window. 

 
The Schematic window: This shows the circuit schematic currently being edited or 

analyzed. The schematic window is actually a window onto a larger drawing area. You can move 

the screen window over the full drawing area using the scroll bars at the right and bottom of the 
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screen. When selecting the New command on the File menu, the system automatically aligns the 

origin of the editor window with the center of the entire editor drawing area. The same is true 

when an existing circuit file is loaded, as this is the default window position. You can think of 

TINA’s schematic as existing on several “layers.” In addition to the primary layer that holds 

components, wires, and text, there are two other drawing layers, which you can turn on or off 

individually. It is generally convenient to have these two layers on. View|Pin Markers On/Off: 

Displays/hides component pin ends. View|Grid On/Off: Displays/hides the grid. A grid of 

closely spaced dots covering the entire drawing area may be made visible or invisible in the 

schematic window, depending on the current state of the grid button of the Grid On/Off switch 

on the View menu. At some schematic zoom levels, you will not see the dots of the grid; 

nevertheless, all component pins and connecting wires will be on the grid. These dots represent 

the only available interconnecting points. Component symbols are positioned on the drawing 

area horizontally and vertically. These symbols are rigid patterns with predefined pin positions 

and are handled as single units. This permits the software to unambiguously recognize the 

network nodes. 

The Tool Bar: You can select most of the editor commands (e.g., select, zoom, wire etc.,) 

from this tool bar. Most commands on the toolbar can also be found under the drop down menus,  

and can often be activated by Hotkeys. We show the menu name separated from the command 

name by a dot (Menu name.Command name ) is shown below. 

 

 

 File.Open) Opens a schematic circuit file (.TSC or .SCH), TINA macro files (.TSM) or 

Spice netlist files (.CIR) / .TSC extension is the current schematic file extension used in TINA 

v9. The files will appear in the Netlist Editor, where you can execute most TINA analyses, and 

edit or complete the netlist. 

  (File.Open from the web) This command starts the built in web browser that allows you to 

navigate to any website and then directly open TINA files with TSC, SCH or CIR extension by 

simply clicking a link. It will also save TSM, LIB, and TLD files into their proper place in the 

user area. Finally, TINA will recognize the.ZIP file extension and will help you select, copy, and 

extract files. By default the built in web browser in TINA opens the TINA circuits on Web page 

on the www.tina.com website (at the time of writing this manual www.tina.com/English/tina/ 

circuits ) where you will find interesting electronic circuit files which you can download or open 

directly from the web and then simulate with TINA. 

  (File.Save) Saves the actual circuit or subcircuit into its original storage location. It is 

advised to frequently save the circuit that you are working on to avoid loss of data in case of a 

computer crash. 

http://www.tina.com/
http://www.tina.com/English/tina/
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(File.Close) Closes the actual circuit or an open subcircuit on the screen. It is very useful 

for closing an open subcircuit. 

  (Edit.Copy) Copy a selected part of the circuit or text to the clipboard. 

  (Edit.Paste) Paste Clipboard contents into the schematic editor. Note that the content may 

come from the schematic editor itself, TINA’s diagram window, or any other Windows program. 

 Selection mode. If this button is pressed you can select and drag components with the 

cursor. To select a component (part), wire or text, just click on it with the cursor. You can also  

select several objects by holding down the Ctrl key and clicking on the objects one-by-one; or by 

clicking at one corner of the area, holding down the left mouse button, moving to the opposite 

corner and then releasing the mouse button. Selected objects will turn red. You can drag the 

selected objects by dragging one of them. Click and hold the left mouse button when the cursor 

is over one of the selected objects and move them with the mouse. You can unselect all selected 

object(s) by clicking on an empty area. One or more selected objects can be deleted while 

leaving the others still selected by holding the Ctrl key down and left-clicking the mouse.You 

can select all the wire segments, connected by the same ID on Jumpers, by holding down the 

Shift Key and clicking one of the wire segments. 

   (Insert.Last component) Retrieves the last component inserted, for a new insertion of 

another copy, with the same parameters as the previous insertion. 

  (Insert.Wire) Use this icon for inserting (adding) wires to the schematic design. 

  (Insert.Text) Add comments into schematics and analysis results. 

  (Edit.Hide/Reconnect) Use Hide/Reconnect to place or remove a connecting dot between 

crossing wire or wire-component connection. 

  (Edit.Rotate Left (Ctrl L), (Edit.Rotate Right (Ctrl R), Rotates the selected component. 

  (Edit.Mirror) Mirrors the selected component. Hotkeys Ctrl L, Ctrl H 

 
 

Switches On/Off the grid. i.e.makes the grid visible or invisible. 

 Explicitly zoom in on a selected portion of the current view. It will also zoom out a portion if 

you just click with the icon into the middle of the area you want to zoom out. 

Select zoom ratio from a list from 10% to 200%. You can also select Zoom All which 

will zoom the effective drawing to full screen. Interactive modes, see also on the Interactive 

menu: 
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DC mode 

 AC mode 

 Continuous transient mode 

 Single shot transient mode, the time is the same as set at Analysis Transient 

Digital mode 
 

VHDL mode 

 With this listbox you can select the analysis and the Interactive Mode Options dialog. 

  (Analysis.Optimization Target) Select Optimization Target to set up Optimization mode or 

to change settings. 

  (Analysis.Control Object) Select Control Object for Parameter Stepping or Optimization. 

  (Analysis.Faults enabled) If this button is pressed it enables component Faults, set by Fault 

property of components. You can set component faults with the Property Editor by double- 

clicking on components. 

   (View.3D view/2D view) Hotkey F6. 2D/3D view. If this button is pressed, TINA’s 

chematic Editor displays circuit components as 3D pictures of the real component assigned to the 

schematic symbol. This is a simple but useful check before starting the PCB design. 

   (Tools.PCB Design) Invokes the dialog which initiates the PCB design module of 

TINA. 
 

(Tools.Find component) Find Component tool. Invokes a 

component searching and placement tool. This tool helps you find by name any component in the 

TINA catalog. The search string that you enter will be found wherever it occurs at the beginning, 

at the end, or anywhere within the component’s name. This tool is useful when you don’t know 

where a particular component is located, or if you want a list of all the components that match 

particular search criteria. A component found in a search can be placed immediately into the 

schematic by selecting it and pressing the Insert button of this tool. 

 Component list. With this tool you can select components from a list. 

The Component bar: Components are arranged in groups, named by the tabs on the 

Component bar. Once you have selected a group, the available component symbols appear above 

the tabs. When you click on the desired component (and release the button), the cursor changes 

to that component symbol and you can move it anywhere in the drawing area. You can also 
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rotate the component by pressing the + or - keys (on your computer’s numeric keypad) or mirror 

it by pressing the asterisk (*) key (also on your computer’s numeric keypad). Once you have 

selected the part’s position and orientation, press the left button of the mouse to lock the symbol 

in place. 

Find component tool: This tool helps you find  by name anycomponent in the TINA 

catalog. See more details above at the toolbar description. 

Open files tab: You can have several different circuit files or different parts (macros) of a 

circuit open in the schematic editor at the same time. Clicking on a tab brings that circuit page up 

in the editor. 

The TINA Task bar: TINA’s Task bar appears at the bottom of the screen and provides 

speed buttons for the various tools or T&M instruments currently in use. Each tool or instrument 

operates in its own window and can be made active by clicking on its speed button (icon of the 

tool). Once the cursor is over the speed button, a brief hint appears. Note that the first button 

(furthest to the left), the Lock schematic button, has a special function. When the Lock schematic 

button is pressed, the schematic window is locked in place as a background behind other 

windows, so that it can never cover a diagram or virtual instruments. When the schematic 

window is not locked and it is currently selected, you will always see the entire schematic 

window with any other windows hidden behind. 

The Help line: The Help line, at the bottom of the screen, provides short explanations of 

items pointed to by the cursor. 
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PART 2 – TINA PCB Design Editor 
 

General Instructions to design PCB Layout using TINA PCB Editor 

 
Creating a Printed Circuit Board (PCB) 

Once circuit diagram is completed, you can design printed circuit board to manufacture your 

design. PCB design is an integral part of the program. Once each component has a satisfactory 

physical part association, 

 
we can proceed to PCB layout design. To do this, press the button on TINA’s toolbar (the last 

icon on the right) or select the “PCB Design” command on the Tools menu. Set the items in the 

PCB Design dialog as shown below. Select “Start New Project”, “Auto placement” and “Use 

board template”. With the Browse button find and select the 1layer_A.tpt template files from 

TINA’s Template. The settings are appropriate for a double-sided PCB. 

 

  (Tools.PCB Design) Invokes the dialog which initiates the PCB design module of TINA. 

 

Figure 3:TINA PCB Launch screen 

 

Setting and checking footprint names 

 
In TINA, it is already assigned default footprint names to all parts which represent real 

components. The most important thing in PCB design is that every part in schematic must have a 

physical representation with exact physical size. This is accomplished through so called 

footprints–drawings showing the outline and the pins of the parts. TINA’s footprint naming uses 

as a starting point the IPC-SM-782A(Surface Mount Design and Land Pattern Standard) and the 
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JEDEC standard JESD30C (Descriptive Designation System for Semiconductor Device 

Packages). (See http://www.jedec.org/download/search/ jesd30c.pdf.) 

 

 
Figure 4:TINA PCB Editor window 

Foot print can be edited using “Footprint name editor” which can be invoked from the Tools 

menu. In this dialog you see all of Tina’s components and the corresponding footprint names 

 

 
Figure 5:Component property editor 

 

Clicking on the footprint name fields, from the available footprint names the required footprint 

can be selected. In the dialog, components that do not already have a footprint name association 

will be denoted by red characters and also by “???” in the footprint name field. 

http://www.jedec.org/download/search/
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Figure 6:Component Footprint name editor 
 
 

 
Figure 7:Component information 

 

If you find the footprint name you want on the list, click on it and press OK: you will be returned 

to the component property dialog with the selected footprint name in the Footprint name line. To 

confirm the change, press OK on the component property dialog again .If you do not find the 

footprint name you want, you can add a new footprint using the Add buttons of the “PCB 

information” dialog. Press the Help button for more information. When everything looks good, 

you can make a final check by clicking the 2D/3D view button. The 3D view of those 

components for which a physical representation has already been added will appear 
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11   22        
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D2 1N4007 

TP3 TP1 TP2 

 

 
 

OBJECTIVE: 

Experiment No 3 

PCB Design – Full wave Rectifier 

To create a schematic drawing with TINA Editor 

To design a PCB layout using PCB Design Editor 

 
 

Editing an Full wave rectifier Circuit Schematic 

Create the circuit schematic for the full wave rectifier circuit as shown figure. Follow the general 

procedure given as General Instructions to Create circuit Schematic Design, to add parts and 

complete the circuit diagram. 

 

D1 1N4007 J3 JUMPER2 
 

R1 1k 

 
R3 1k 

 

 

   

 
 
 
 
 

 

 
 

Figure 8: Fullwave rectifier circuit diagram 
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Figure 9: Circuit schematic of Fullwave rectifier circuit diagram in TINA Schematic Editor 

Generate Bill of Materials from File menu- Bill of Materials 

# Quantity Label Value Footprint 

1 1 C1 100u CP_CYL80_D200_L470 

2 1 R1 1k R_AX800_W200 

3 1 R2 1k R_AX800_W200 

4 1 R3 1k R_AX800_W200 

5 1 R4 1k R_AX800_W200 

6 1 RL 1k R_AX800_W200 

7 1 D1 1N4007 DO41-10 

8 1 D2 1N4007 DO41-10 

9 1 J1 JUMPER2 JP100 

10 1 J2 JUMPER2 JP100 

11 1 J3 JUMPER2 JP100 

 
Invoking TINA PCB Design 

 

Figure 10: Invoking TINA PCB Editor 

 

Once each component has a satisfactory physical part association, we can proceed to PCB layout 

design. To do this, press the button on TINA’s toolbar (the last icon on the right) or select the 

“PCB Design” command on the Tools menu. Set the items in the PCB Design dialog as shown 

figure. Select “Start New Project”, “Auto placement” and “Use board template”. With the 

Browse button find and select the 1layer_A.tpt template files from TINA’s Template. 
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Finally, you can set the size of the PCB board in inches or mm depending on the measurement 

unit settings in the View/ Options dialog of TINA. When everything is set properly, press the OK 

button and the PCB layout design will appear with all the components automatically placed on 

the PCB board. 

 

 

Figure 11: Autoplacement of components TINA PCB Editor 

 

If you want to reorient the components, click the required component and drag the parts to new 

positions as, shown on the figure 

 

 
Press F4 to invoke the Net Editor and set nets routing width. First, click on “Modify all” and 

enter 25 mil into the “Track width” field. Then select power nets (Ground, VCC, -VCC) and set 

their widths to 25mil. 

 
To automatically route the netlist, press the F5 button or select “Autoroute board” command 

from the Tools menu. The following screen will appear: 

 
To finish the design, let’s add a text box to the silkscreen/ assembly layer. To do this, click the T 

button on the toolbar. The following message will appear 
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Enter the text into the empty upper field and press the OK button. The text will be attached to the 

cursor. Move it to the place it on either Top/Bottom layer and press the left mouse button. 

 

 
 

 
Figure 12: Fullwave circuit after routing and lablin in TINA PCB Editor 

 

To see if everything is routed correctly, press F7 or select DRC (Design Rule Check) from the 

Tools menu. The following message will appear: 
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Finally, you can check your design in full 3D. To do this, press F3 or select 3D View from the 

View menu. After some calculation the following window will appear 

 

 
Figure 13: 3D View of Top and Bottom side of PCB 

 
You can rotate the 3D model and zoom in and out with the control arrows at the bottom. You can 

display or hide these arrows through the Options menu with “Use control arrows” checkbox. 

You can also rotate this 3D model by clicking with the mouse at any point, holding down the left  

button and moving the mouse. 

After this you can either print your design or create a Gerber file for a manufacturer. To print use 

Print…from File menu. To obtain Gerber files to direct a photo plotter, choose Export Gerber 

file from File menu. (Gerber option can be changed through Gerber output setting under Options 

menu.) 
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Generate the following output files 
 

 

Assembly Drawing 
 

Silk screen 
 

Solder mask (Bottom) 

Routing (Bottom) 
 

NC Drill Drawing 
 

Top and Bottom layer 
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Design outputs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Result: 
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EXERCISE 4 

 

ASSEMBLY AND TESTING - FULL WAVE RECTIFIER 

OBJECTIVE: 
 

To assemble and test full wave rectifier circuit and to measure voltage drop across resistive 

network. 

COMPONENTS REQUIRED: 
 

S.NO COMPONENTS NAME VALUE QUANTITY 

1. PCB for full wave rectifier 

and voltage drop resistive 

network 

- 1 

2 Digital multimeter (DMM)- - 1 

3 Resistors 1 kΩ ,500 Ω,10 kΩ,4.7 k, 
2.2 kΩ,22 kΩ 

Each 1 no 

4 AC power supply, connecting 

wires 

- 1 

5 soldering kit - 1 
 
 

CIRCUIT DIAGRAM: 

 
D1 1N4007 
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22 
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R3 1k 

 
 
 

 

 

  
 
 
 

 

 

 

PROCEDURE: 

1) Assembling the circuit 
 

   Assemble the circuit by placing the diode, capacitor, connector and resistors in the PCB 

as per the assembly diagram shown in the figure. 

Bend the resistors lead to the appropriate size before inserting them into the board. 
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   Solder the resistor on bottom side of PCB board using soldering iron. 

2) Testing the circuit 

a) Connect the AC source from step down transformer to jumper J1 and J2. 

b) Connect the positive terminals of multimeter to point TP1 and negative terminal to GND. 

c) Measure the voltage V1 between  TP1 and GND 

JOIN JUMPER 3 THEN. 

d) Measure the voltage V2 between TP2 and GND 

e) Measure the voltage V3 between TP3 and GND. 
 

 
V1  

V2  

V3  

f) Measure the voltage across the individual resistor and note the values in the table below. 
 
 

Resistor Resistor value 
Voltage drop across the 

resistor (v) 

RL  V(RL) = 

R1  V(R1) = 

R2  V(R2) = 

R3  V(R3) = 

R4  V(R4) = 
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Calculate Vin=( V(R1) + V(R3) + V(R4) )= + + + = -------- V 

Calculate Vout=( V(RL))= ------ V 

 
3) TROUBLE SHOOTING: 

 

a) Set the digital multimeter the continuity mode. Unplug the device or switch off the circuit 

before attempting a continuity test. Check the continuity between all five nodes. 

b) When the resistor value differs from the circuit, the output value also differs. 
 

RESULT: 
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EXERCISE 5 
 
 

 

 
OBJECTIVE: 

Single side PCB Fabrication 

 

To fabricate single side PCB for full wave rectifier circuit and resistive network. 

COMPONENTS REQUIRED: 
 

S.NO COMPONENTS NAME VALUE QUANTITY 

1. Single side copper clad PCB (2.5 x 2.5) Square inch 1 

2 Digital multimeter (DMM) - 1 

3 Ferric chloride solution and 

etching equipment 

 1 

4 Drilling machine 0.8mm 1 

 

ROUTING DIAGRAM: 
 

PROCEDURE: 
 

Print bottom layout of the PCB design in a photo paper using high quality resolution 

Clean the single side copper clad thoroughly using fine emery sheet. 

Place toner side (Print side) on copper side of PCB 

Using Electric Iron box, press gently on the paper until the full toner transferred to the 

clad side 

   Dip the clad in Ferric chloride solution and rinse for 5 -10 min until the unmasked copper 

get removed. Clean with fresh water. 
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Then clean the surface with using fine emery sheet. 

Make through hole using 0.8mm drill in all the pads 

 

 

Testing: 

Using digital multimeter, in continuity mode, Test for continuity of tracks, and short circuit. 

RESULT: 
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